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http://dreamers.workamper.com

Our goal with this site, and 
the accompanying Dreamers 
Blog, is to provide you 
with as much information 
as possible to assist you 
in learning, investigating 
and evaluating your ability 
to begin and maintain 
the Workamping lifestyle. 
Support and perspective to 
help you begin Workamping 
on the right foot!

• Four Steps to Workamping
   Freedom Course
• Interviews w/Workampers
• Dreamer Excercises
• Steve’s Dreamers Blog
• Online Event Library
• Resources
• Dream Series
• 101 Questions

Main Tools or Features:

Workamper Dreamers

Who can login: Dreamers, 
WorkamperPlus, Silver and Gold
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Login with:  email address 
and password created when 
you joined



Workamper.com
www.workamper.com

Main website that includes 
information and articles to 
help you learn about the 
Workamping lifestyle and 
make it successful, plus the 
tools you need to find jobs 
and get employers to find 
you.  Education and research 
will help you acquire the 
right position for you.

• Awesome Applicants Resume
• Online WKN magazine
• Hotline ads
• Employer Tours

• Praise Your Employer
• Viewpoint Articles
• Workamper University
• Situations Wanted Ad Submit
• Workamping FAQs
• Webinars

• Featured Employers
• Volunteer Resources
• Training
• Workamper Glossary
• How to Find a Job
• Sample Work Agreement

Main Tools or Features:

Who can login: WorkamperPlus, Silver 
and Gold members.
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Login with:  email address 
and password created 
when you joined



The forums is a SEPARATE 
site from Workamper.com 
so it has separate login 
criteria. Use this site to share 
about your Workamping 
experiences, research and 
ask questions to get other 
Workampers’ perspectives.

• Connect with Workampers

• Get real-life answers to  
   your questions
• Workamper Experiences

• Solo forum
• RVs for Sale/Buy
• Amazon forum
• Dreamers forum

Main Tools or Features:

http://forums.workamper.com
Workamper Forums

Who can login:

Login with:  username and 
password created when you 
registered to this site

Public Forums - 

Members Forums - 
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Anyone in the general public can use the Public 
Forums.

WorkamperPlus, Silver and Gold members 
have access to private, members-only forums 
too.
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Find your Workamper 
friends and create your 
own profile so they can find 
you! Navigate to main tools 
from here or participate in 
the Community by creating 
a profile with info and 
pictures, and finding and 
connecting with Workamper 
friends. Employers DO NOT 
have access to this site. Your 
Community profile is not, 
and does not connect to, 
your resume.

• Quick Links to Main Tools
• Create/Edit your Profile
• Photo Galleries
• Search for Friends
• Blog
• View Friends’ Profiles
• Send Messages

Main Tools or Features:

Workamper Community
http://community.workamper.com

Login with:  email address 
and password created when 
you joined

Who can login: WorkamperPlus, 
Silver and Gold members.



Club Workamper will provide 
you with the ultimate avenue 
of connection between 
members who have a similar 
desire to connect & develop 
quality relationships. You’ll 
find resources to further 
educate yourself on how to 
be a successful Workamper 
and get the jobs you desire, 
while connecting with 
fellow members. Additional 
webinars and online courses.

• Member Profiles

• Member Forums
• Member Chat
• Gold RoundTable Webinars

• Member Map
• Marketing 101 course
• Online Newsletter
• Storytellers (videos)
• Ask the Expert Webinars (Gold)

• Workamper Tool Box
• Helpful Articles
• Gold member cards

Main Tools or Features:
Login with:  first and last 
name (ex. Luke & Jody 
Duquette) and club site 
password

www.clubworkamper.com
Club Workamper

Who can login: Silver and Gold 
members
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How Do I Change My...
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You can do all three of these online.  WorkamperPlus and above 
members: Log In to Workamper.com, click on the Log Out & Settings 
tab and a drop down menu will appear.  Select Change Email Address, 
Password,  or Mailing Address and it will take you to the edit page.  
Fill out the form as directed.  When you have your new info entered, 
click on the Update or Send button.

If it successfully updates, you will see an “Update Complete” 
message at the bottom of the frame. You will also receive an email 
reviewing your information.

Silver & Gold members: You can change your Club Workamper login 
password when logged in at the Club site - click on the Your Account 
link and select To Change Your Account Details.

Basic members, please send an email or call the office to update your 
mailing address.

- Mailing Address
- Email Address
- Website Log In Password

You can also call the office (800-446-5627) to make any 
changes of your addresses or passwords, or send an 

email to info@workamper.com

Mailing address changes must be made by the 
18th day of even-numbered months, to ensure 
the change is made for the mailing of the next 
issue of the magazine - i.e. February 18th for the  
March/April issue.
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Once you create and save your online 
resume it will be added into the database 
that is searched by our employer 
subscribers.  They will contact you directly 
if they are interested. Or, you can easily 
email your AA resume to employers you 
are interested in.

You can create and maintain your resume 
using the AA Resume Builder. There is a 
box for you to enter your availability date, 
so you can keep your resume active in 
the database all the time. There is also a 
box you can check to have your resume 
non-active in the database if need be. 
Employers can sort their search results by 
availability date and by the date you last 
edited your resume, so be sure to update 
often!

The Resume Builder is a step-by-step 
tool. You will see each step in a tab along 
the top. On the first tab - Intro page, you 
will see a link to email your resume, how 
many times your resume has been viewed, 
and when your resume was last updated.

As you are creating or editing your 
resume, remember to CLICK THE SAVE 
BUTTON AT THE BOTTOM OF EACH PAGE   
before moving to next tab section. If you 
do not click the Save button, you will lose 
any information you just entered. Click the 
Preview button any time to see how your 
resume will look to employers. When you 
are in Preview mode, there is a link at the 
top and bottom to take you to a Print View 
if you would like to print and mail your 
resume.

Tab 2 - Applicant Info. Enter your contact 
information, season preference and 
availability date.

Tab 3 - Work Settings & Compensation. 

Select the types of employers you are 
interested in, salary/benefits and schedule 
preferences.

Tab 4 - Work Location. Select the U.S. 
states and Canadian Provinces you would 
like to work in. Please really take this 
into consideration and don’t select “Will 
Consider All” unless you really will work/
live anywhere.

Tab 5 - Sell Yourself. Type up a few 
paragraphs about you (and your partner) 
and your Workamping experience. Please 
do not write up this section in Microsoft 
Word and then copy/paste. This could 
break your resume. Please use a program 
like Notepad or TextEdit instead.  If you 
must copy/paste in your text, please click 
on the button in the editing toolbar that 
has a small clipboard and letter T icon. 
Paste your text into the window that 
opens, and then click Insert. Then use 
the editing toolbar to add formatting like 
bolding, bullets, etc.

Tab 6 - Your Photos.  You can have up to 
three photos. We recommend a close up, 
a photo of you in front of your RV, and a 
photo showing your entire RV. Photos 
must be jpeg format. The upload tool will 
automatically re-size the photos for quick-

Awesome Applicants Resume
Put Yourself Out There



viewing.  If your photo is directly 
off of a nice digital camera, it 
is likely that the file size is too 
large for the upload tool to 
handle.  If you have trouble and 
your photos will not upload, this 
is likely the case. Please re-size 
your photos before uploading if 
possible. For assistance, contact 
jody@workamper.com

Browse to find each photo 
where it is saved on your 
computer. Click on the Upload 
Images Now button and when 
your photos have uploaded 
successfully, click the Save 
button. If you have slower 
Internet, we recommend doing 
one photo at a time. Photos 
cannot be deleted from your 
resume, but you can upload 
new photos over existing 
photos to replace an image.

We recommend updating 
your resume every other 
month. Any resumes that have 
not been updated within one 
year will be inactive.  

How do I find the AA Resume Builder?: 
• Go to www.workamper.com, click on the 
Member Log In tab and login. Then click on 
the AA Resume Builder tab.
or
• Click on the I am a Workamper tab -> mouse 
over Put Yourself Out There -> Awesome 
Applicants
or
• If you’re on your Community Home page, 
click on the Awesome Applicants link in the 
Quick Links box.
or
• On the login page below where you type in 
your password, select Awesome Applicants 
from the drop down menu options and you’ll 
be taken right to the tool upon logging in.

Why I should make and update my resume: 
• Works for you 24/7/365
• Email your resume to anyone (and it logs  
   each send)
• Easy step-by-step tool to create and maintain 
• Hundreds of Employers search the resume  
   database

Where Can I Get Help With My Resume Content?: 

• Viewpoint Articles - At Workamper.com, click on the Viewpoint tab ->  
  Viewpoint Articles and scroll to the Job-Finding Tools Category. There are  
  multiple articles.

• When you’re in the AA Resume Builder tool, go to the Sell Yourself section  
  and there’s a link to view a sample.

• Developing Your Resume - recorded Dreaminar with Jaimie. Login to the  
  Dreamers website and click on Let the Dream Begin -> Online Event Library  
   -> September 2010 webinar

• Workamper Marketing 101 - online course from Steve Anderson. 
  www.workamper.com/fivesecrets

• Online course and Resume Makeovers from Jaimie at  
  www.workamper.com/education

11
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Situations Wanted Ad - Print
Put Yourself Out There

The Situations 
Wanted Ad (SW) is 
used by Workampers 
to advertise to 
Employers; it’s just 
another way to get the 
word out to Employers 
that you’re available!

All members can 
run  up to a 30-word 
ad in each issue of 
Workamper News 
magazine; that’s six 
times a year (a $45 
value per issue). 
Just submit your ad 
using the online ad 
form. Once your ad 
is scheduled, you’ll 
receive a confirmation 
email from us.

You can include 
whatever you want 
in your ad text, but 
you must include your 
contact info - how 
you want Employers 
to get in touch with 
you. If you have an AA 
Resume, mention that 
too!

Put in your ad what 
season you’re looking 
for, location, job type, 
what you can bring 
to the Employer, any 
experience or skills, 
etc. View past issues 
of the magazine for 
examples.

How do I find the SW submit form?:

• If you’re a Basic or WorkamperPlus member - go to 
Workamper.com and click on the I am a Workamper 
tab -> Put Yourself Out There -> Situations Wanted ad.

• If you’re a Silver or Gold member - login at 
Workamper.com first. Then click on the I am 
a Workamper tab -> Put Yourself Out There -> 
Situations Wanted ad.

Why I should run a SW print ad:
• One more way Employers can find you!
• Not enough of our Workamper members take  
  advantage of this...so you’ll be one in a few!
• Print magazine provides wider and more long-term  
  exposure.
• Can be working to find a position for future seasons.

In case you’re wondering...Your Awesome Applicants Resume 
number is your subscriber/member number. Employers can find your 

resume searching on your number, your name, or your email.
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Situations Wanted Online (SWO)
Put Yourself Out There

Silver and Gold members can take their 
Situations Wanted advertising one step 
further. In addition to running a print ad 
in the magazine, you can also post an 
online Situations Wanted Ad (SWO).

When you submit your SWO ad, it 
will  be displayed on the Workamper 
Employer website for 2 months. (If you 
need your ad removed sooner, just 
email/call the WKN office.) 

Your online ad can be up to 75 words, 
and will automatically display whatever 
contact information you fill out on 
the submit form, so you don’t need to 
include it in your ad text. You can also 
check a bubble to include a link to your 
AA Resume (the link is generated for you 
automatically).

Use the online form to submit your 
SWO ad and print ad for the magazine 
at the same time if you want. You will 
receive an email confirmation once your 
online SWO ad is posted (your ad goes 
into our admin tool and we’ll proof it 
for you before making it active). You will 
receive a separate email to confirm your 
ad in the magazine, if you submitted one.

You can view your submitted SWO 
ad too. When you are logged in to 
Workamper.com, click on I am a 
Workamper and mouse over Put Yourself 
Out There. In the flyout menu, click on 
View Situations Wanted Ads. This page 
will show your current SWO online ad, as 
employers see it. If you need to edit your 
SWO ad, copy the text, go to the SWO 
form, paste your ad text in the box and 
make any changes and submit.

You can run one SWO ad at a time, as 
often as you like throughout the year.



Hotline - Email & Website Page

Hotline Website Page

Find A Job
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The Hotline page can be accessed once 
you login at Workamper.com.  This page 
will display all the Hotline ads from the 
current week - which is the last seven days.  
The default is to show you all ads, with the 
newest on the top.

At the top of the page, you will see state 
abbreviations for the states that have 
active ad(s) running.  Click on a state to see 
only the ads for that state.

Other links along the top of the page 
provide additional sorting options.  Click 
on “Select All by State” to view the ads 
alphabetically by state.  Click on the 

The two main avenues for 
viewing Workamper Opportunity 
listings are the magazine and the 
online Hotline. Some Employers 
will only advertise in the magazine; 
some will only advertise on the 
Hotline; some will do both; some 
will do neither and just search 
the Awesome Applicant resume 
database.

Each weekday, employers submit 
Hotline ads. Once we receive them 
to our office and get them processed, they are immediately posted to the Hotline page 
at Workamper.com.  So you will see new ads showing up on this page throughout the 
morning/afternoon.  Then, at 4 p.m. CT, our system compiles all of the new Hotline 
ads for that day into an email and begins blasting it out to members. The Hotline 
email will come from hotline@workamper.com - please put that in the Address 
Book/Safe Senders within your email program.

Please note:  There is no Hotline archive available on our sites. This is because many 
of the positions are immediate start. But, you can create your own archive by creating 
a folder in your personal email program, and put your Hotline emails in there. Then 
use the search option within your email program if you are looking for a specific ad 
or criteria.

“Today” link to view just today’s new ads.
One other feature of the Hotline page is 

the search box. Here you can type in any 
keywords like “volunteer” or “host” or 
“$$” (if you’re looking for positions that 
provide wages). Type in your keywords 
and click the Search button to view any ads 
that meet your criteria.

In the top right of the Hotline page, you 
will see a link that reads “Send me an email 
when a new job is posted” or “Do not send 
me...”  This is the on/off switch for the 
Hotline Job Alert Emails. 



Hotline Job Alert Emails
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How do I find it: Go to your email inbox.

Why I want to use it:
  • Quickly review new opportunities for  
     that day

  • Notification of new opportunities  
     available to you

  • Create your own archive of Hotline  
     emails to search through when you’re  
     actively looking for a position

Turn them on/off on the Hotline 
Website Page

How do I find it: 
On the login page at www.workamper.com, click on the drop down menu 
below the box where you type in your password and select Hotline. You will 
automatically be taken to this page upon login.

Or, log in to www.workamper.com. If on main site, click on I am a Workamper 
tab, mouse over Find a Job and click on Hotline from the pop out menu.  

If on Community Home page, click on Hotline link in the Quick Links box. Or 
find the link under the Favorites tab.

Why I want to use it:
  • New job listings each weekday
  • Organize opportunities quickly by state

If you are in “job search” mode, the 
Job Alert Emails may be something you 
want to turn on. Be one of the first to 
know about the new, available positions!  
As soon as we schedule a new Hotline ad 
(anytime between 9 a.m. and 4 p.m. CT), 
you can receive an email containing that 
new ad.  

This means you will receive 1-25+ 
emails that day, depending upon how 
many new ads there are. You will also 
still receive the main Hotline email in the 
early evening containing all of that day’s 
Hotline ads.

  • Keyword search capability
  • Turn on/off Job Alert emails



Online WKN Magazine
Find A Job

Workamper® News magazine is published bi-monthly 
(six times a year). The magazine contains Workamper 
Opportunitiy listings (generally for the next season or year-
round positions), plus articles on Workamping experiences, 
RV maintenance, RVing & Workamping resources, Classified 
ads, Staff Corner, Workamper Viewpoint column and more!

Basic and above members have the option of receiving the 
hard copy of the issue in the mail. WorkamperPlus and above 
members can receive the hard copy in the mail, and view the 
online version too. If you’ve selected “Green” membership, 
we won’t mail you a hard copy and you will just view the 
magazine online.

The online version of the magazine is exactly the same as 
the print version. We DO NOT send the magazine by email. It 
is a PDF file or Flash flipbook file that you open and view in 
your internet browser. You can go through every page, zoom 
in/out, save the whole thing to your computer, print any page, 
and do keyword searches.  You can go online any time of any 
day to view the current or past issues. 

A new issue will be placed online after the print version of 
the magazine is put in the mail - i.e. the March/April issue will 
go online the last week of February.  You just need to log in to 
Workamper.com and go to the Workamper News Magazine 
Online page to open and view the issue.

On the issue archive page, the newest issue will be on top. 
You can view past issues as well.  Just click on the link for the 
file type you would like to view. We recommend reviewing 
past issues for Workamping opportunities and other helpful 
info. You can also save the magazine file to your computer 
for easy access without having to connect to the Internet.

How do I find it: 
Log in to Workamper.com and click on Online Magazine 
tab. Or, click on the I am a Workamper tab, mouse over 
Online Tools and click on Online Workamper News 
Magazine from the fly-out menu.

If on your Community Home page, click on Workamper 
News Magazine Online link in the Quick Links box. Or 
find the link under the Favorites tab.
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Why I want to use Flipbook:
  • More fun
  • Table of Contents
  • More links to access more 
info with one click
  • Toolbar on the left

Won’t be able to view this 
version on iPhone/iPad.

Why I want to use PDF:
  • Opens faster on slower 
internet connections
  • Best zoom capabilities
  • Toolbar along the top

Add the issues to the 
iBooks section on your 
iPhone/iPad for easy 
review/access.

Mac users, you can also 
use Preview to view the 
issue.

Below are some things you can do using Adobe 
Acrobat Reader once you have the magazine open. 
Most of these options are located in the toolbar along 
the top (or bottom depending on your browser).

Zoom In/Out.  You can zoom in to get a closer look or 
make the text larger for reading.

Jump to Pages. If you know of a specific page you are 
looking for, you can type in that page number in the box 
next to the  /60 and then hit Enter.  Or, you can use the 
blue arrows to the left of the page number box to click 
up a page or down a page - one page at a time.

Keyword Search. On the right side of the toolbar, you 
should see a white box with the word Find in it. This will 
search all the pages and compile the pages that have 
that keyword on it.

Print. Click on the Printer icon, or go to File -> Print.
Save file to your computer so you will not need to go 

to the internet next time you would like to open it. On 
the issue archive page, right click on the PDF link then 
select “Save Link As…” – in the window that appears, 
select the location on your computer where you want 
to save the file to, rename the file if you want to, and 
then click the Save button. If you already have the file 
open, go to File -> Save As.

The flipbook version is a bit more animated and 
reads more like an actual magazine. It has all of the 
same options as the PDF version - these options are 
located in the tool bar along the left side of the window.  
Additional tools include a table of contents where you 
can click to go directly to a certain section or state.  All 
email addresses and website URLs are linked so you 
can click on them.  You can also click on the binoculars 
icon at the end of an ad to be taken to that employer’s 
Employer Tour.
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PDF Version (Adobe Acrobat Reader)

Flipbook Version (Flash)

Read the online tutorial for even more detailed instructions. At Workamper.com 
click on I am a Workamper -> Online Tools -> Workamper.com Tutorials.

Or, watch a recorded webinar showing you all the ins & outs of utilizing the 
Online Magazine.
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More Opportunities
Find A Job

How do I find it:
Go to 
www.workamper.com/FE

Or at Workamper.com, 
click on I am a Workamper 
-> Find a Job -> Featured 
Employers.

Or click on the photo that 
rotates in the top right of 
Workamper.com and it will 
take you directly to the FE 
page that corresponds with 
that photo.

How do I find it:
Go to 
www.workamper.com/
volunteer

Or at Workamper.com, 
click on I am a Workamper 
-> Workamper Volunteer 
Resources.

How do I find it:
At Workamper.com, click 
on I am a Workamper -> 
Find a Job.

Employers who have opted to share more about their 
Workamping opportunities are Featured Employers. 
The Employers who select this subscription level 
create a website page with information, images, and 
sometimes video to help you learn more about what 
they have to offer Workampers.

At www.workamper.com/FE you will find the list and 
a brief description of all the Featured Employers. Click 
on the Featured Employer Page link that displays below 
the logo image to view that Employer’s page.

The contact information and also maybe info on their 
application process will be included on their page.

Visit this page often as new Featured Employers 
come on board throughout the year!

The idea of giving back to communities, the nation, 
or particular humanitarian organizations motivates 
many retired RVers to volunteer for Workamping jobs. 
Volunteering is an American tradition that provides 
immeasurable contributions to society on both a 
national and community level.

In this section you will find articles and recordings 
providing information and Workampers’ perspectives 
on volunteering, along with Volunteer Opportunities 
that have been submitted to Workamper News. The 
Recent Government Listings link will show you an 
updated list of current, open volunteer positions 
posted on volunteer.gov 

There are a few other pages on our website that may 
contain current Workamping Opportunities:

- WorkCamping for Charities
- Business & Income Opportunities
- Career Opportunities

Featured Employers

Volunteer Resources

Additional Opportunities
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Employer Tours
Researching an Employer

This tool is a great starting 
point for when you are 
researching an Employer you 
have interest in working for. The 
Employer Tour provides a visual 
introduction to the Employer’s 
location and environment they 
provide.

EmployerPlus subscribers to 
Workamper News can create an 
Employer Tour, which includes 
a description, their logo, and 5 
photos with captions.

We encourage Employers 
to upload photos that show 
off the working and living 
environment at their location; 
i.e. if it’s an office job, show 
behind the desk, and show an 
RV site so you’ll have a better 
idea if the environment would 
be right for you.

When you come to the 
Employer Tours page, you’ll see 
a list of all current Tours. You 
can sort the list by clicking on 
the column headers - Employer, 
City, State, Category. Click on 
the name of the Employer to 
open that Tour.

When viewing a Tour, click on 
a picture to see a larger view of 
it and the caption (if provided). 
Use the “Prev” and “Next” links 
to switch between the photos.

Click on the Return to Tour 
Selection link to go back to 
the full list of Tours. We hope 
this tool will come in handy, 
especially if the Employer does 
not have a website.

How do I find it: 
Login to Workamper.com and click on the I am a 
Workamper tab -> Find a Job -> Employer Tours.

Why I want to use it:
  • Brief description of the location/environment

  • Pictures (hopefully) showing off the living and  
     working environment you would experience

  • Good starting point when researching your next  
     potential Employer



Praise Your Employer (PYE) is in the 
Viewpoint section at Workamper.com 
since it is a tool where all the info 
comes from you, the Workamper.

When you are researching an 
Employer, search for them in PYE to 
see if other Workampers have had a 
positive experience with them and 
then contact those Workampers for 
more info.

Search for an Employer by company 
name, city or state. Type in the 
company name or city or select a 
state, and click on the Search button. 
You can also sort the list by clicking on 
the column headers - Employer, City, 
State. In the main display, it will show 
you the Employer name, any stars 
awarded and the date the last star was 
awarded.

Double click on a red star award 
to see the email address of the 
Workamper who awarded that star. 
Then click on the email address to 
send that Workamper an email with 
a request to share more info.  In your 
email, please try to ask some specific 
questions and include your name and 
email address they can reply to.

Then, go a step further...double 
click on the Employer name and...it 
will take you right to the WKN Forums 
site and do a keyword search on that 
Employer name pulling up any existing 
topics containing that Employer name! 
Note: Be sure you are registered and 
logged in to the WKN Forums site first 
(see page 22 for more on that).

Praise Your Employer
Researching an Employer

When in Research Mode
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Not finding the employer you are researching 
in the list?  Check the spelling or try searching 
just on the city or state as a Workamper awarding 
a star may have spelled the name incorrectly. 
Or, this may mean it has not been a positive 
experience for others, but please be sure to do 
thorough research!

How do I find it: Log in to Workamper.com 
and click on Viewpoint tab then Praise Your 
Employer from the drop down menu. Or if 
on your Community Home page, click on 
the PYE link in the Quick Links box.

Why I want to use it:
  • To see if any Workampers had a positive  
     experience with the Employer you’re  
     researching.
  • Contact the Workamper(s) who posted  
     the star(s) to ask them specific questions  
     about the experience.
  • Double-click on the Employer name to  
     be taken automatically to the WKN  
     Forums site where a keyword search is  
     completed for you.
  • Give props to an Employer you had a  
     good or great Workamping experience  
     with.



The other side to the Praise Your Employer tool -- Award a star to Employers you had 
a good to great Workamping experience with.  You can award a star to an Employer 
that you have worked for within the last two years.  Remember, the more folks utilize 
this tool, the stronger it will be when you’re on the research side, so please participate.

Award Your Employer
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First - Search to see if your Employer 
already exists in the PYE database.

If your Employer is not yet listed - 
Click on Add Employer & Star.

Notes:

If you find your Employer, click on them to highlight their row. Then click on Add 
Star Award. Select the year you worked for them; check or un-check the box 
saying it’s okay for other Workampers to email you with any questions, and then 
click the Submit button.

Type in the Employer’s Name (company name) and city, then select the state, the 
year you worked for them, and then check or un-check the box saying it’s okay 
for other Workampers to email you with any questions. Click the Add button to 
submit your award.

If you would like to Praise Your Employer, but don’t really want to be contacted by other 
Workampers with questions, that’s okay! Just un-check the ‘allow email’ box when awarding 

your star. Please still submit your star award to continue the expansion of this tool for you and 
your fellow Workampers.

Star awards only reflect the last two years.



22

Workamper Experiences Forum
Researching an Employer

When in Research Mode

How do I find it: 
It’s a separate website so you can type 
http://forums.workamper.com into your 
address bar in your internet browser 
and then save it as a bookmark/favorite. 

OR, click on the Forums tab at 
Workamper.com.

Why I want to use it:
  • Read about other Workampers’  
     experiences with the employer  
     you’re researching.

  • Request info about an employer if  
     there’s nothing yet posted.

  • Share your experience with other  
     Workampers to help them out in  
     their future job hunting.

This forum is a venue for 
Workampers to share about their 
experience with a specific Employer. 
Searching the Workamper Experiences 
(WE) forum should be one of your 
steps in researching a potential 

Employer. All posts in 
this forum are made by 
fellow Workampers, and 
remember, what is right 
for one may not be right 
for another so read, ask 
additional questions, and 
do an individual evaluation 
of the info presented.

A post can be about a 
positive, negative, good, or not-so-
great experience. Start by clicking 
the Search link near the top of the 
site to do a keyword search to find 
out if there is an existing topic on the 
Employer you’re researching. If not, 
you can create a new topic asking for 
information; click on the New Topic 
button when in the WE forum, fill out 
your subject line and post, then click 
the Submit button.

Topic names in the WE forum include 
the feeling of the experience - POS, 
NEG, WRN - as well as the state, the 
employer name and sometimes the 
city or year worked there, so it’s easier 
to quickly identify if the post is useful 
to you.

Want to privately touch base with 
a person who posted about their 
experience? Use the Email button or 
PM (Private Message) button to send 
them a message directly.
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When you are logged in to the 
Forums site, you can post a reply 
to any existing topic or create a 
new topic.

Click on any of the forum 
names to go into that specific 
forum. Within each forum is a list 
of topics and within each topic 
there are replies. 

If visiting the Forums site looking to do some research, start by clicking the Search 
link near the top and do a keyword search for what you’re looking for to first see if 
there are existing topics.  If nothing yet, find the forum your topic best fits in and click 
the New Topic button - type in your subject line, what you want to say in the message 
body and click the Submit button.

Your fellow Workampers have taken the time to post about the experiences they 
have had with Employers, and we hope you will do the same to further the usefulness 
of the Workamper Experiences forum.

Any topics or posts made in the Workamper Experiences forum must be approved 
by a moderator before the post will appear live on the site. You will receive notification 
when your post is approved, or a request to make revisions to your post before it can 
be made active.

Share YOUR Experience

1. Once on the site, click on the Register link.
2. Create a username that will appear with any replies 
    or topics you post. Please do not use your subscriber/ 
    member number or your full email address.
3. Enter your email address in the appropriate box.
4. Create a password. This can be the same password you 
    use to login to workamper.com if you like.
5. Once you have the rest of the register form filled out, 
     click the Submit button.
6. An email will be sent to you with a link to click to verify 
    your registration. Once you have clicked the link to  
    verify, you can login to the Forums site.
7. A WKN staff member checks for new registrants daily. 
    If you are not added to the Members group and see the  
    Workampers or Workamper Experiences forums within  
    a day, please send an email to: 
    forumadmin@workamper.com

A SEPARATE LOG IN is required for the Forums 
site. You will need to create a username 

(preferably not your member/subscriber number) 
and a password. Here’s how you do that

Anyone can register 
and use the WKN 

Forums site. 
WorkamperPlus, 
Silver and Gold 

members of WKN 
receive access to two 
additional, members-

only forums.

How to Register:



Workamper Community
Connecting With Other Workampers

How do I find it: 
When you Log In to Workamper.com, you 
can select to be taken to your Community 
home page using the drop down box below 
where you type in your password. 

Or at Workamper.com, click on I am 
a Workamper tab -> Online Tools -> 
Workamper Community.

Why I want to use it:
  • Find fellow Workamper friends and send  
    messages with them.

  • Share your photos with friends and blog  
    about your experiences.

The Workamper Community is a site where 
you can create a personal profile to share with 
other Workampers in the Community.  Once 
there, you can navigate to all of the main tools 
and sections of Workamper.com. You can also 
find your membership expiration date.

There are two important things to note here:

1. EMPLOYERS DO NOT HAVE ACCESS. Your 
Community Profile does not need to read 
like your Awesome Applicant resume.

2. YOU DO NOT HAVE TO PARTICIPATE. 
You do not have to have a profile in the 
Community to use the other sections or 
tools of Workamper.com.

Edit Your Profile.  Click on Community 
Tools -> select Edit Profile. Go through each 
tab and fill in your information and add Your 
Photo. Be sure to click the Submit or Add 
button at the bottom of each page to save.

Photo Galleries. Share photos with your 
Friends. Click on the Gallery/Image tools link 
on the home page. Upload your jpeg images 
– the tool will automatically re-size them 
if they are too big. You then add captions, 
Name Your Galleries, then Assign Images to 
those Galleries.  If you want to send a photo 
in an email or post it to the Forums or your 
Blog, click on the View My Image URLs link 
and copy/paste the link of the photo.

Your Blog.  A Blog can be like an online 
journal. Click on the Your Blog link on the 
home page. Click on the Add Blog Entry link 
at the top of the page to create a new Entry. 
Type in your Subject line and then the Blog 
text. Click the Add button and the Blog will 
be added to the top of your Blog. To Edit, 
View and Delete a specific blog in your list, 
use the small icons to the right.

Friends.  Your Friends can see your Profile 
and can send messages to/get messages 
from them. To Make Friends, click on the 
Browse Community link. You can sort the 
listings in many different ways, or you can 
do a Search for a specific person or couple. 
When you find the listing, click the red 
Make Friends tab and a Friend Request will 
be sent to that person. When they accept 
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Using the Site

the Friend Request, they will automatically be 
added to your Friends list and you will be added to 
theirs. Click on the Browse Friends link to see all of 
your Friends - use the tabs on their listing to Send 
Message or Remove Friend from your list.  Be sure 
to check the Friend Requests link when you log in 
to see if someone has sent a Friend Request to you.



How do I find it: 
Go to www.clubworkamper.com and login 
with your username and password. Then 
from the list of sections on the left, click 
on My Profile.

How do I find it: 
Go to www.clubworkamper.com and login 
with your username and password. Then 
from the list of sections on the left, click 
on Member Map & Locator.

Your Profile on the Club Workamper 
website is similar to your profile on the 
Community site, but it is separate.  The CW 
site is only accessed by fellow Silver and Gold 
members; it is not accessible to employers.

Update and use often! Move your flag 
on the map as you travel across the U.S.  
Find out if any fellow members will be 
in an area you are interested in staying/
working in; contact them and ask them 
questions about the area.

Once in the map, click on Map Info for 
Your Name and then Edit Map Information 
to place or move your flag. Click on the 
Members box to find a member on the 
map by name. Zoom in and out using the 
toolbar on the left - it works like Google 
Maps. Click on a flag to see who the flag 
represents. How-to videos available on 
the Help Videos page.

Use the links across the top in the green 
rectangle to create and edit your Profile. 
Click on My Friends to view those who you’ve 
‘made friends’ with so far, and to find the All 
Users link which will show you all members 
who have created a Profile.

Click on the Help link on the top for a video 
on how to create and maintain your Profile.  Or click on the Help Videos link on the left for 
help with uploading photos.  Use the Profile section to put a face to the folks you talk with 
during webinars or chat with on the Forums or Club Chat room.
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Create Your Profile

Use the Map

Profile and Member Map
Connecting With Other Workampers

Also check out the 
Club Chat page and 
the Member Forum 
to share ideas, ask 

questions, and further 
network with others.
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More Club Workamper Tools
Take It to the Next Level

This is an online course from WKN 
President Steve Anderson, and it will 
be a excellent source of information on 
marketing yourself as a Workamper. You 
will learn how to develop, implement 
and make sellable your Personal 
Marketing Strategy.  Don’t leave your next 
Workamping experience up to chance!

During this course you’ll learn:
1. The #1 thing to focus on while 

developing your Personal Marketing 
Strategy. (Most Workampers don’t develop 
a strategy, and definitely don’t know this!)

2. How to craft your Personal Marketing 
Strategy so it sells!

3. Steve’s secrets to developing a 
Personal Marketing Strategy that will “let 
your light shine brighter!”

4. How to implement your Personal 
Marketing Strategy after you build it. (Hint: 
It is not as easy as you think, and it’s not as 
hard either!)

5. The most critical mindset shift you 
need to make before attempting to develop 
your Personal Marketing Strategy. Don’t 
even bother with all of the steps Steve’s 
going to teach you if you’re not willing to 
do this!

There are five videos in the course; each 
is a WMV file that will play in Windows 
Media Player (if you’re on a Mac, you’ll 
need a plugin. See page 29).

You also have outline/notes handouts 
you can print before watching each session, 
and some homework handouts. These are 
PDF files that will open in Adobe Acrobat 
Reader.

Recommend reading. Browse through 
WKN President Steve Anderson’s personal 
picks for improving your focus and your 
mindset to better achieve the lifestyle of 
your dreams.

An online newsletter published each 
month or bi-monthly. View the current and 
past issues on the Newsletter page. Each 
newsletter is a multiple page PDF file that 
will open in Adobe Acroat Reader, so you 
can zoom in/zoom out, print any page, do 
keyword search, or save to your computer.

Issues include helpful articles, an 
employer spotlight, updates and new 
resources, member spotlights and more.

Announcements, resources, and other 
information for Workampers and RVers.

Provided by Workamper Agency Services, 
LLC.  Go through the different tools to help 
you: determine what your wants and needs 
are; develop your marketing plan; begin 
acquiring the elements for your Agency 
Profile (www.workamperagency.com). 

How do I find it: 
All of the mentioned tools here can 
be found in the list of pages on the 
left side on the site when logged in at  
www.clubworkamper.com

Login using your CW username and 
password.

If not a Silver or Gold member, this 
course can be attended for $99 tuition at  
www.workamper.com/fivesecrets 

Workamper Marketing 101

CW Library

Newsletter

Article Index

Workamper Tool Box
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Gold members have two monthly 
webinars they can attend (learn more 
about Webinars on page 28). Attend live or 
watch the recordings at your convenience.

RoundTable Sessions will allow you to 
experience and learn how other members 
are improving their Workamping lifestyle. 
It will also be a chance to get to know your 
fellow members and ask questions. These 
webinars are all about you - so members 
do all the talking.

Ask the Expert webinars will provide 
you with the opportunity to ask any and 
all questions you may have about RV 
maintenance, living the RV lifestyle, how 
to manage your taxes as a Workamper, 
and more. Join experts like the Texas RV 
Professor - Terry Cooper, the RV Tax Master 
- George Montgomery, and the RV Lifestyle 
Expert - Jamie Hall Bruzenak during these 
special webinar events and get your 
questions answered! These experts are 
volunteering their time to be on these 
webinars with you.

When you register to attend a RoundTable 
or Ask the Expert session, submit with your 
registration any topics or questions that 
you would like discussed (whether you can 
attend live or will just watch the recording 
later).

Gold members are provided one set 
of 500 personalized business cards. 
Utilize your business card to build new 
relationships and easily share your 
information with future employers!

Click on the Club Cards link, fill out the 
provided form and submit your request.  
There are three different designs to choose 
from. Fill out the form with whatever 
contact information you want included 
on your cards. TRIPLE CHECK YOUR INFO 
BEFORE SUBMITTING! We will print exactly 
what you submit.

Staff member Jody will create your cards 
and send them to our printer. You will 
receive notification when your cards have 
been printed, and we will mail them to you 
via USPS Media Mail. This process could 
take up to 4-6 weeks after submission.

Provided by Workamper Agency Services, 
LLC.  Go through the Workamper Tool Box 
to begin creating your Agency Profile. As 
a Gold member, the Agency will review 
and validate your employment timeline in 
addition to storing and sending out your 
Profile upon request.

The best resource for a Workamper is 
their fellow Workampers.

It’s great to be able to learn from the 
experiences had by others. Here, you will 
find perspectives and stories from current 
employers, Workampers, and your fellow 
members.

Sample Gold member business card

Two Monthly Webinars

Business Cards

Additional Agency Support
Workamper Storytellers

Gold Member Tools
Take It to the Next Level



28

Webinars
Educational & Fun

A webinar is an online gathering where one person presents a topic while 
attendees listen in, or a group of people connect for a discussion/chat session 
- all taking place on your computer via the Internet and a free program called 
GoToWebinar.  The most difficult part of attending a webinar is making sure it fits 
into your schedule. If it doesn’t - no worries, we record them! We have hours...and 
hours of videos that you can watch at your convenience to help you learn about 
different Workamping topics 
or hear the answers to many 
frequently asked questions.

Webinars may seem 
technologically intimidating, but 
once you attend one, the rest 
just get easier! Here are some 
tips and things to do to make 
your webinar experience easier.

Special Note: You do NOT 
need to sign up for GoToMeeting 
and pay a monthly fee (which 
you will see advertised on their 
website). Workamper News 
pays for GoToMeeting so we 
can host these webinars for our 
members and the public. Please 
do not enter any free trials or 
contracts with GoToMeeting 
unless you would like to put on 
and host your own webinars.

How do I find it: 
• Go to www.workamper.com/webinars

• Visit the Webinars page under the I am a  
   Workamper tab -> Online Tools

• Login at the Dreamers website - 
   http://dreamers.workamper.com - then  
   click on Let the Dream Begin tab ->  
   Online Event Library

On these pages you’ll find upcoming 
events as well as recorded webinars that 
you can watch at your convenience.

What you need to attend a webinar: 
• An email address
• A computer
• Connection to the internet
• If you want to be able to share verbally  
   during a live webinar you’ll need a  

microphone connected to your computer, 
or you can call in on your telephone.

Gold Members - you have EVEN MORE 
webinar opportunities. Login at  
www.clubworkamper.com and visit the 
Gold RoundTables page and the Ask the 
Experts page for monthly webinars you 
can attend live or watch later.

www.workamper.com/
webinarinfo

Help with registering for 
webinars, attending live, and 
watching recorded webinars.
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You’ll need to register, which just means 
submitting your name and email address. 
To do this, click the registration link 
provided and submit your info. Depending 
on the webinar type, there may be a 
questions box on the registration page 
where you can type in your question and 
submit it with your registration. 

You will then receive a few reminder 
emails from @citrixonline.com which is the 
company that provides the GoToMeeting/
GoToWebinar services. These emails 
include the link to click to join the webinar 

Once you have joined a webinar, sit back, 
relax and enjoy! If you have questions, 
you can submit them using the type-chat 
box provided in the GoToWebinar control 
panel that will appear on your screen. You 
can also click a button to “raise your hand” 
to be un-muted and ask your question 
verbally. 

If your slow internet connection 
does not allow you to connect on your 

Recordings will usually be placed on the 
same page where you went to register for 
the webinar. A webinar recording will be a 
.wmv file which is Windows Media Video.

For PC users, the video will open and play 
in Windows Media Player. For Mac users, 
the WMV file will play within your browser 
using Apple Quicktime, but you may need 
to install a free plugin named “Flip4Mac” 
(find the link on the workamper.com/
webinarinfo page).

If you are on a slower internet 
connection, or have limited minutes with 
your air card, you can save the recorded 
webinar file to your computer for viewing 
without being connected to the Internet. 

Register & Prepare

Attending Live

Watching a Recorded Webinar

on the specificied time and date. It’s okay 
to join the webinar about 5-10 minutes 
before the actual start time.

SET YOUR TIME ZONE! When you are on 
the registration page, look near the top 
where the date and time of the webinar 
is displayed. Next to this is a blue link that 
reads “Show in my time zone”. Click this link 
and select your time zone from the drop 
down box. This will change the time so it 
displays in the time zone you selected - it 
will change it on the registration page AND 
in the emails you receive after registering.

computer, you can still call in and just listen 
to the audio over your phone. The phone 
number and access code are provided in 
the confirmation/reminder emails you 
should have received.

You can also attend a webinar via your 
iPad, iPhone or Android device using 
the free GoToMeeting app.  See the  
workamper.com/webinarinfo page for 
details on using and downloading the app.

To do this, right click on the link to the 
recording, select “Save Link as...” and in the 
window that appears, select the location 
on your computer where you want to save 
the file to. If the recording opens in your 
browser, right click on it and select “Save 
As Source.” 

The file will download to your computer, 
and then you will be able to watch that 
recording by clicking on the file where it’s 
saved on your computer.

TROUBLESHOOTING: If you cannot view 
a recording because of a codec error, 
go to www.gotomeeting.com/codec to 
download the free GoToMeeting codec 
that will fix this problem.
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Viewpoint Articles
Educational & Fun

Workamper Viewpoint! If you have an 
interest in working, camping and enjoying 
life - this section is for you. Whether you 
are an experienced Workamper or a 
curious reader, you can find all of your 
Workamping answers here. Feel free to 
explore the articles we have provided.

Many of the articles are written by 
Viewpoint Editor and author, Jaimie Hall 
Bruzenak.  Some of the articles written 
about a Workamper Experience come from 
the Workampers themselves.

The articles are divided into categories: 
General Issues, Industry 
News, Job-finding Tools, 
Technical,  Workamper 
Experiences, Workamping 
Families and Getting 
Started.

Double click on an article 
title to open and read.

Peruse the Job-finding 
Tools section for many 
great articles to help 
you with writing your 

resume!

How do I find it: 
At Workamper.com, click on the 
Viewpoint tab and select Viewpoint 
Articles from the drop down list.

If you login to Workamper.com first, you 
will have access to even more articles.

Why should I read these: 
Gain knowledge of different 
Workamping experiences, how to write 
your resume, RVing tips, and much 
more!



Workampers and Employers 
working together to 
better the Workamping 
Community!

The Agency is a separate company from 
Workamper News, Inc.  As a sister 

company of Workamper News, Inc., it will 
be working closely to provide advanced 
systems of accountability for those who 
desire more assurance in their futures.  

Workamper Employers can participate 
by submitting any 
Workampers that have 
accepted their positions 
to the Agency online 
database. To further 
develop their program, 
they can become involved 
in our Quality-Checked 
Employer option to provide Workampers 
with a profile that will assist you in your 
consideration process.

The Agency database is a permission-
based system. When an Employer submits 
you into the database as hired, it is up to 
you to confirm your listing by clicking a 
link in the email sent to you.

If you have invested in a Silver or Gold 
membership, you have the option to 
further participate in Agency and request 
that the Agency provides you with 
additional services. You will also have 

the opportunity to step up your level of 
Assurance by being represented by the 
Agency to future employers who are 
looking for what you have to offer.

Yes, there are those who will sit back 
and do nothing to improve their future 
odds. This is true of Employers and 
Workampers alike.  They want a system 
that will provide them assurance without 
accountability. Life requires action! 
Will you be one who steps up and takes 
action to put yourself into a “Place for 
Assurance?”

2. Approve Your Accepted Workamper Position If your Employer is an EmployerPlus 
subscriber to Workamper News, they can submit you as a hired Workamper in the Agency 
database.  If the info is correct and you’d like to approve the listing, click the link in the email.

3. Silver & Gold Members  Go through the Workamper Toolbox and acquire your materials to 
begin creating your Agency Profile.

1. Review the Agency Website and the Pledge  Go to the website and watch the video and 
read the info available.  Check out the Workamper & Employer Pledge.



Fun and Adventure
Chapter and BOF Rallies  
Organized Tours • Escapades

Knowledge and Education
Educational Seminars • Website
Magazine • Discussion Forums 

Parking Options
Rainbow Parks • SKP Co-Ops
Discount Parks (Travel Guide)

Support Services
Membership Benefits 

RV Advocacy

Membership Benefits

Freedom Awaits

JOIN NOW!
Save $10 on your new membership.
Use Code 104 when you join.

ESCAPEESRVClub©

A TOTAL SUPPORT NETWORK FOR        RVERS

Special Savings Offer for
Workamper News Subscribers

www.escapees.com

888-757-2582
$10
SAVINGS

Adventure, Education 
& Support Services
 Escapees Mail Service (best in the nation)
 Escapees magazine (speaks for itself)
 51 chapters (US, Canada, Mexico)
 50 BOFs (groups sharing common interests)
 Escapades (educational entertainment)
 HOPs: unique land, sea and air adventures
 Website packed with RV resources 
 Escapees Club News (stay informed!)
 Escapees E-News (advocacy news alerts)
 Strong RV advocacy coalition 

A Comprehensive 
RV Park System 
 Rainbow Parks—friendly, clean and fun
 Inexpensive overnight parking 
 Dry-camping $5 per night (limited stay) 
 E-mail stations, WiFi and phone services* 
 Enjoy activities, workshops and meals 
 1,000+ commercial parks offering discounts
 Home-base options 
 Short- and long-term leases 
 Pay three (weeks) get one (week) free* 
 Discount parking 
 *Depending on location and availability


